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Mapeo de Redes de Colaboración 

 

Introducción: ¿de dónde viene la pesquisa? 

 

Hoy se empieza a percibir la importancia de mapear redes de colaboración. Para 

allá de la observación y el registro de un fenómeno social, esa tarea puede catalizar el 

desarrollo de una nación. Por eso, esta ponencia viene a divulgar el trabajo ejecutado en 

el sentido de entender cómo se constituyen estas redes: demuestra una metodología para 

visualizar los lazos que se construyen entre investigadores y las telas de conocimiento 

que resultan de su interacción. Para tanto, expone procedimientos de inserción y 

procesamiento de datos en el programa de computación Pajek. Las descubiertas aquí 

expuestas son parte de una investigación en andamiento apoyada por el Consejo 

Nacional de Investigación de Brasil (CNPq)2. 

Brasil vive un período crítico de su historia. El crecimiento por que pasa ha 

tomado por la primera vez un carácter inclusivo, buscando la diseminación de las 

ganancias económicas por toda la estructura social. Sin embargo, el país está cerceado 

por la crisis internacional, y las dificultades internas de la deuda pública imponen 

restricciones presupuestarias. Además, hay un reconocimiento unánime de que este 

proceso encuentra aún muchos gargallos que pueden desacelerarlo o mismo frenarlo. 

Dos de los más expresivos son la falta de trabajadores cualificados y el carácter poco 

innovador de la producción de mercancías. 

                                                           
1
 Graduado en Relaciones Internacionales (2010) por la Universidade Federal do Rio Grande do 

Sul, Brasil. El autor agradece a la profesora Denise Leite por su orientación. 

2 El “Conselho Nacional de Desenvolvimento Científico e Tecnológico” es una agencia del 

Ministério da Ciência e Tecnologia (MCT) destinada al fomento de la pesquisa científica y tecnológica y 

a la formación de recursos humanos para la pesquisa en el país, conforme se presenta en su sitio: 

<http://www.cnpq.br>. 



Por consiguiente, el gobierno nacional tiene la conciencia de que son necesarios 

investimentos para transformar esta situación. Una de las más recientes iniciativas del 

Estado fue el lanzamiento del plan “Brasil Maior”3. Como para que haya innovación es 

necesario haber profesionales creativos y capaces, es una condición obvia la necesidad 

de ampliar la formación de personal. De ahí la importancia del programa “Ciência sem 

Fronteiras”, que debe ofrecer hasta 2014 75 mil becas de estudio en el exterior4. Frente 

a un investimento tan grande, en un sector tan sensible y en tiempos de restricción de 

gastos, cabe preguntar: ¿cómo hacer para que este esfuerzo tenga el máximo efecto? 

El gobierno brasileño ha, tradicionalmente, financiado el estudio de sus élites 

académicas en el exterior, aunque en escalas muy más restrictas que las actuales. Tal 

expediente, con todo, no ha generado ventajas conducentes para la sociedad. El 

conocimiento se concentró en las universidades y poco se difundió entre la población 

como un todo. La simple ampliación de un sistema excluyente apenas lo hará 

acompañar el crecimiento cuantitativo de la nación, no sirviendo para reforzar los 

avances en la inclusión social. Es preciso evaluar el histórico hasta el presente, y 

analizar los puntos positivos y negativos del sistema de formación de alto nivel. 

 En ese escenario, importa indagar que han hecho los científicos con la 

cualificación que les ha propiciado el Estado. La estructura académica brasileña 

privilegia la producción de obras, destacadamente artículos y su publicación, 

especialmente en el exterior. Tal producción es evaluada cualitativamente no en 

términos de su contenido o de su repercusión social, pero por la reputación del medio en 

el cual es publicada. Ocurre así un doble efecto: por un lado, la investigación científica 

brasileña creció y se destacó en el ámbito académico internacional; de otro, poca 

consideración se da al modo como se llegó a esa producción y muchos docentes-

investigadores trabajan aislados de sus colegas y alumnos. Hay que descubrir como 

reforzar los aspectos positivos de estas políticas para que prevalezcan sobre sus 

imperfecciones. 

 

 

Proyecto de Pesquisa: Evaluación y Redes de Colaboración 

 
                                                           
3 Véase a ese respecto la carta del plan en <http://www.brasilmaior.mdic.gov.br/wp-

content/uploads/cartilha_brasilmaior.pdf>. 
4 Como se puede leer en su sitio: <http://www.cienciasemfronteiras.cnpq.br/>. 



La producción aislada no es el único modo de trabajo de los investigadores. De 

hecho, se fortalece la tendencia a la constitución de redes de colaboración entre 

investigadores, un fenómeno que debe ser estimulado para propiciar una mayor 

circulación de la innovación en la investigación académica. En este sentido, la profesora 

Denise Leite ha lanzado el proyecto de pesquisa “Avaliação e Redes de Colaboração: 

inovação e mudanças nas teias de conhecimento”, apoyado por CNPq. El estudio busca 

entender la forma como el conocimiento se disemina y las transformaciones y progresos 

que imparten en ese proceso con los avances tecnológicos y sociales. Comprende que la 

innovación en los métodos de pesquisa es crítica para mejorar las formas como 

repercuten las innovaciones producidas. 

En su resumen ejecutivo, Leite (2011) expone: 

As questões de pesquisa que se colocam inicialmente dizem respeito a: Como se 
formam as redes de colaboração? Quais poderes e hierarquias? Como se formam as 
teias de conhecimento? Quais as mudanças na ciência acadêmica? Quais os fatores 
endógenos e exógenos que influem sobre as mudanças? A metodologia de caráter 
qualitativo e quantitativo prevê a realização de levantamento de dados sobre 
pesquisadores e grupos de pesquisa na base de dados DGPB5, CNPq, rastreamento de 
redes de colaboração dos pesquisadores, com emprego de software de visualização de 
redes e de estatísticas básicas. Entrevistas e estudos de caso serão realizados com a 
finalidade de conferir sentido aos dados quantitativos manipulados. São resultados 
previstos geração de conhecimento (circulante, recurso e produto) na perspectiva 
nacional e internacional; inovação e mudanças na academia pós-avaliações e mudanças 
na pesquisa (ciência) acadêmica (p. 1-2). 
 
La base de datos fundamental de este trabajo es la Plataforma Lattes, recurso de 

CNPq que agrega los currículos de los investigadores brasileños6. El análisis de su 

producción, especialmente de aquella desarrollada en cooperación con otros 

profesionales es la base de nuestra pesquisa. Entendiese que cada vez que dos o más 

personas se unen para crear una obra se teje un hilo a un tiempo social y científico. 

Siempre y cuándo se repetir esa práctica, nuevos hilos se acrecen al espacio de la 

pesquisa, hasta el punto en que se forman telas de conocimiento. 

                                                           
5Diretório dos Grupos de Pesquisa no Brasil, accesible en: 

<http://dgp.cnpq.br/buscaoperacional/>. 

6 Las informaciones catastradas en la Plataforma Lattes tienen, aplicabilidades como subsidio a 

la evaluación de la pesquisa y del posgrado, para juicio sobre aptitudes de candidatos a bolsas y auxilios y  

selección de profesionales. El sistema se encuentra en: <http://lattes.cnpq.br/>. 



En ese sentido, Molina, Muñoz y Domenech (2002) recuperan las obras de 

Diana Crane y Derek Solla Price7. Para este último, 

[…] la investigación científica parece seguir una curva en forma de S (curva logística) 
en la que es posible identificar una etapa inicial de aparición del paradigma, una 
segunda etapa de multiplicación de las contribuciones y, asociada a la aparición de 
“Colegios Invisibles” o círculos de investigadores influenciados por unos pocos 
investigadores de alta productividad, una tercera fase de madurez y una última de 
estancamiento. Estos trabajos se basan principalmente en el recuento de citas, aunque 
también incluyen, como es el caso del trabajo de Crane, otros tipos de relaciones 
(dirección de tesis doctorales, comunicación informal e influencia en la selección de 
problemas). 
Crane asimila “Colegio Invisible” a círculo social, en el sentido que los integrantes de 
un circulo social solamente conocen a una parte del total pero están influidos por 
personas con las que no están conectadas directamente. Por “conectividad” entiende la 
existencia de un camino que una a dos científicos en una dirección determinada, 
independientemente de su longitud. Por tanto, el énfasis de esta aproximación se centra 
en el establecimiento de la red total en la cual se hayan insertos los autores, sean 
conscientes o no, y en el cálculo de la conectividad existente. Ésta determinará la 
existencia de “Colegios Invisibles”. (p. 2) 
 
Los colegios invisibles, cual sea su conectividad, son redes sociales, y como 

tales pueden ser mapeadas. De acuerdo con Oliveira, Santarem y Santarem Segundo 

(2009), 

 [...] em geral, em pesquisas recentes, o conceito de rede social e análise dessas relações 
tem sido desenvolvido como forma de medir a colaboração científica entre os 
pesquisadores, instituições e países para visualizar a frente de pesquisa de determinada 
área. (p. 313) 
 
Vemos que aquí las ciencias humanas piden el préstamo de la ciencia de la 

información. A la medición de la colaboración científica, procedemos por medio de los 

estudios de coautorías. Este tipo de investigación es parte del campo más amplio da 

temática bibliométrica. En el dicer de Alves (2009), 

A bibliometria constitui de um conjunto de leis que estudam quantitativamente o 
comportamento da informação registrada. Assim, os estudos bibliométricos investigam 
o comportamento do conhecimento e da literatura, visando basicamente a análise 
quantitativa do conhecimento registrado, quer sejam: da produção científica dos autores, 
da produtividade de periódicos sobre determinado assunto, de mensuração e avaliações 
quantitativas dos processos referentes à utilização de documentos, análise de co-
autorias, rede de comunicações científicas, análise de avaliação da produção cientifica, 
calculo do fator de impacto, etc... (p. 106) 
 
Con base en los datos provenientes de la pesquisa bibliométrica, podemos 

construir una imagen correspondiente a las telas de conocimiento. Logramos ver lo 

invisible de las estructuras sociales: lazos que muestran caminos no obvios por los 

                                                           
7 Las obras en cuestión son Invisible Colleges: Diffusion of Knowledge in Scientific 

Communities (1972), de Crane; y Little Science, Big Science (1963), de Solla Price. 



cuales la información y la innovación se transmiten, cruzando las fronteras entre 

universidades y países. Sobre la relación entre las redes de individuos y la estructura 

social, De Nooy, Mrvar y Batagelj (2005), afirman: 

The social sciences focus on structure: the structure of human groups, communities, 
organizations, markets, society, or the world system. In this book, we conceptualize 
social structure as a network of social ties. Social network analysts assume that 
interpersonal ties matter, as do ties among organizations or countries, because they 
transmit behavior, attitudes, information, or goods. Social networks analysis offers the 
methodology to analyze social relations; it tells us how to conceptualize social networks 
and how to analyze them. (p. 3) 
 
Los mismos autores atestan que la inspección visual ha sido una herramienta 

importante en la investigación de redes sociales desde el origen del campo. Por eso, 

unen en su obra los fundamentos de la teoría y las aplicaciones de Pajek. Su promoción 

del software es en sí un ejemplo de la difusión de innovaciones. El manual del programa 

esloveno fue publicado por una editora británica con sede en siete países e impactó en 

las pesquisas de Oliveira, Santarem y Santarem Segundo (2009), para quienes “do ponto 

de vista metodológico, pode-se afirmar que a utilização de técnicas de visualização de 

redes sociais utilizando o software Pajek é bastante recomendável para representar 

graficamente a configuração das redes de co-autoria” (p. 325). 

Además de ser capaz de representar las redes tejidas en un solo período, Pajek 

puede generar secuencias de grafos que ilustran las diferentes etapas de un espacio de 

tiempo, lo que converge con la opinión de León y Gil-Mendieta de que “cabe señalar 

que si bien las figuras pueden usarse como herramienta exploratoria, son la 

visualización de la composición y estructura de la red en un momento o periodo 

determinado” (p. 14). 

 

 

Explorando Redes con Pajek 

 

Pajek es un software libre desarrollado por Vladimir Batagelj y Andrej Mrvar, 

con la contribución de Matjaž Zaveršnik, todos profesores de la Universidad de 

Ljubljana, en Eslovenia. Del esloveno ven su nombre, que significa “araña”. El 

programa es usado ampliamente para analizar y visualizar redes. La versión más actual 

de Pajek, la 2.04, está disponible en su sitio para download y uso no comercial. La 

gratuidad y libre disponibilidad del software, bien como la facilidad para instalarlo y su 

rapidez  son los principales motivos que llevaron a su utilización. Sin embargo, el uso 



de Pajek está también difundido en la comunidad científica, siendo mismo reputado por 

ser capaz de trabajar con volúmenes mayores de datos que sus congéneres, como el más 

conocido Ucinet8. 

En Pajek, las redes se constituyen y se expresan a partir de tres tipos de 

elementos básicos: los vértices, las aristas y los arcos. Cada vértice (en el inglés 

original, vertex) corresponde a un individuo u otra unidad de pesquisa. Los vértices 

pueden conectarse de dos formas. La primera, la arista (edge), es una línea simple, no 

direccionada, uniendo dos puntos a la vez. La segunda, el arco (arc), es una línea 

direccionada, con punta de flecha. 

Aunque haya diversas maneras de usar Pajek, como para evaluar la cohesión de 

una red o la centralidad de sus componentes, presentamos aquí el modo que 

consideramos más adecuado a los objetivos de nuestra pesquisa: la representación 

gráfica para proceder a la inspección visual. Otros investigadores ciertamente darán más 

atención a otros aspectos y funciones del programa, y conocerán formas diferentes de 

utilizarlo, más a hondo. Pero nuestra intención con esta ponencia es compartir los 

conocimientos que obtuvimos con la exploración de Pajek, dándoselo a conocer a 

quienes no sepan de sus aplicabilidades y demostrar las aplicaciones de nuestro abordaje 

a aquellos que ya trabajen con este recurso. 

En la representación gráfica de una red de colaboración científica, los 

investigadores equivalen a un vértice y las relaciones que tejen entre sí configuran 

aristas o arcos. El uso de una u otra forma de representación puede darse de acuerdo con 

el diseño de la pesquisa: aristas indican una cooperación bidireccional o equilibrada, en 

la que los dos autores contribuyen del mismo modo para la realización del trabajo, y que 

ambos comparten sus habilidades en la consecución de sus objetivos; arcos demuestran 

que la participación de un de los individuos fue preponderante, o sea, que se dio una 

transmisión de conocimiento más intensa de un investigador a otro, ocurriendo así una 

cualificación del segundo autor por el primero. 

En ambos los casos, transcurre una construcción en la estructura de saberes de 

cada investigador, ya que la asociación lleva no apenas al intercambio de las 

informaciones directamente abordadas en el trabajo, pero también al establecimiento de 

                                                           
8
 Ucinet es un paquete estadístico para el análisis de datos de redes sociales. A diferencia de 

Pajek, es un software pago, aunque haya una versión shareware, descargable desde < 

http://www.analytictech.com/ucinet/description.htm>. 



un lazo a través del cual fluyen datos pasados, descubiertas presentes y oportunidades 

futuras. A la medida que el investigador avanza de una colaboración a otra, forma 

nuevos lazos e fortalece aquellos ya existentes con nuevos trabajos. Por lo tanto, el 

registro de esas conexiones en Pajek evoca la imagen de la tela de conocimiento que 

teje el profesional a lo largo del tiempo. 

La inspección de esa estructura sirve para apuntar los rumbos que toma el saber 

en una comunidad de científicos, la capacidad que tiene un investigador de difundir el 

conocimiento que adquiere y acumula, bien como la medida y la formas en las que 

ejerce esa capacidad. Permite, además, mensurar el progreso que promueve con el 

avanzo de su carrera: tratase de ver más allá de la perspectiva productivista, en la que lo 

que importa es la cuantidad de obras que un individuo puede fornecer, para desvelar la 

acción de ese mismo individuo en el sentido de interaccionar en su investigación, su 

intención de compartir saberes desde el inicio del proceso generador de conocimiento. 

En ese sentido, es importante que los recursos de Pajek posibilitan conocer la red del 

profesional no apenas en su forma final, consolidada, sino que también su conformación 

en el pasar de los años. 

En el estudio piloto en que se embasa esta ponencia, fue averiguado el currículo 

académico de la profesora Denise Leite, inscrito en la Plataforma Lattes. A partir de los 

datos públicos disponibles en línea, fueran apurados sus trabajos publicados en forma de 

artículos científicos, libros y capítulos de libros, en el período de 2001 a 2010. Cada 

obra de estos tipos publicada en los últimos diez años, bien como las asociaciones con 

otros autores en su producción, fue compilada en el procesador de planillas Microsoft 

Excel e, a partir de estos registros, siguió el mapeo de la rede de la investigadora en 

Pajek. 

 

 

Construyendo Mapas de Redes en Pajek 

 

Demostraremos ahora la ilustración de una red con Pajek a partir del ejemplo de 

contabilización de asociaciones de la profesora Denise Leite para la elaboración de 

artículos científicos. La creación de una red en Pajek puede ser hecha directamente por 

la inserción de los datos de cada vértice en el programa. Ese es, entretanto, un itinerario 

más trabajoso y demorado que aquello que hemos seguido. En nuestra pesquisa, hemos 

utilizado el editor de texto simple Bloc de Notas, un utilitario patrón del sistema 



operacional Windows. Para que un archivo de texto sea leído por Pajek es necesario 

construirlo con una serie de características, conforme la figura abajo. 

 

 

Gráfico 01 

Vértices y aristas descritos en el Bloc de Notas 

 

En la primera línea, son enumerados los vértices que forman parte de la red. En 

seguida, los vértices son descritos, cada cual en su línea, dándoseles sus características. 

Al lado del número correspondiente a cada vértice, pódese agregar su nombre, entre 

comillas. De lo contrario, Pajek los rotulará automáticamente como “1, 2, 3, …” cuando 

sea comandado a generar la imagen de la red. Además del nombre, podemos describir 

como características del vértice forma, tamaño, color y posición. Esas diferenciaciones 

son útiles caso deseemos resaltar las especificidades de los individuos referidos por los 

vértices. Por fin, incluimos entre corchetes los años en que los autores estuvieron 

activos o aquellos en que queremos que sean representados en el grafo. 



En este estudio, llevamos en consideración la ubicación de un investigador en el 

mismo grupo de pesquisa, en la misma universidad o en el mismo país que la autora 

estudiada. Así, están representados por un cuadrado (box) los investigadores que hacen 

parte del mismo grupo de pesquisa e tienen la misma nacionalidad de la autora 

estudiada; por un rombo (diamond) aquellos que participan del grupo, pero no trabajan 

en Brasil; por un triángulo (triangle) los brasileños que forman parte del grupo; y por un 

círculo (ellipse) las personas que no pesquisan desde Brasil ni toman parte en su grupo 

de pesquisa, pero mantienen una relación de producción académica común. 

Abajo de los vértices, empieza la lista de aristas o de arcos, conforme se desee 

representar relaciones direccionadas o no. En este estudio, optamos por utilizar 

solamente aristas, dado el alto grado de colaboración entre los autores. Describimos, así, 

la cantidad de producciones conjuntas entre los pares en un determinado período de 

tiempo. De este modo, en las dos primeras columnas, listamos los vértices que serán 

conectados y, en la tercera, el valor de esta ligación: 1 caso haya una coautoría en el 

año, 2 si colaboraron en dos trabajos en aquello año, y así por adelante. Si el 

investigador analizado ha publicado sólo, inserimos su número tanto en la primera 

cuanto en la segunda, indicando en la tercera la cantidad de ligaciones con uno mismo. 

Al fin de la línea, ponemos entre corchetes el período de tiempo en el cual se dieron las 

colaboraciones. En nuestra pesquisa, utilizamos como base de periodización temporal el 

año de publicación. 

Una vez listados todos los vértices, aristas y arcos que se desea representar, 

salvamos el archivo en el Bloc de Notas, a través del comando “Archivo > Salvar 

cómo”. Para que Pajek pueda leerlo, cambiamos la opción patrón de salvar el texto con 

la extensión .txt para “todos los archivos” y acrecemos la extensión .net, que 

corresponde a los archivos de red en Pajek. 

 

 

Gráfico 02 

Salvamento de archivo en el Bloc de Notas 



 

Encerrado el proceso de descripción de la red, abrimos el software Pajek. En su 

ventana inicial, clicamos el ícono correspondiente al comando “Read Network” en la 

sección “Networks”, dónde se operan las acciones relacionadas a apertura, salvamiento 

y modificación de redes. Seleccionamos el archivo .net en el camino que lo hubiéramos 

salvo y Pajek lo cargará. Una vez cargado el archivo, podremos pasar a trabajar con la 

red. 

 

 

Gráfico 03 

Ventana inicial de Pajek 

 

Para obtener una imagen inicial de la red, basta utilizar el comando de dibujo 

“Draw > Draw” del menú superior de Pajek. El programa abrirá una nueva ventana, 

demarcando los vértices y aristas, dispuestos de forma uniforme en un patrón circular. 

Es posible alterar esta disposición utilizando las opciones del comando “Layout”, en 

esta misma ventana. 

 



 

Gráfico 04 

Imagen inicial de la red 

 

Para obtener una mejor idea de la intensidad de los vínculos entre investigadores 

y de la participación de cada autor en una red, es posible efectuar algunas alteraciones 

en Pajek. En la propia ventana de dibujo, seleccionamos el comando “Options > Lines > 

Different Widths” para que la espesura de las aristas corresponda al volumen de 

producciones conjuntas entre los investigadores-vértices que unen. Volviendo a la 

ventana inicial de Pajek, usamos el comando “Net > Vector > Summing up values of 

lines > All” para hacer con que el tamaño de los vértices representados sea proporcional 

al número de artículos publicados de cada autor. En seguida, para que este comando 

tenga efecto en el grafo, clicamos en “Draw > Draw Vector”. 

 



 

Gráfico 05 

Imagen de la red en proporción 

 

Otra distinción que se puede hacer en el análisis de la red de investigadores es 

tomar en consideración el origen académico del investigador. Por medio de la guía 

“Partitions”, es posible agrupar los vértices atribuyendo a ellos un valor específico para 

cada universidad. Antes de todo, generamos una partición a través del comando 

“Partition > Create Constant Partition”, con la dimensión igual al número de vértices de 

la red. En seguida, clicamos el ícono correspondiente al comando “Edit Partition” en la 

sección “Partition”, dónde se operan las acciones relacionadas a apertura, salvamiento y 

modificación de particiones dentro de una red. Podemos entonces dividir los vértices en 

particiones que, en este caso, corresponderán a las universidades a que pertenecen los 

investigadores. Podemos salvar esa partición a partir del propio Pajek, para que no 

tengamos que hacerla otra vez caso deseemos repetir el trabajo en otra sesión. Para eso, 

clicamos el comando “Save Partition” en la sección “Partition”, y obtenemos un archivo 

con la extensión .clu, característica de las particiones de Pajek.  

Ejecutando el comando “Draw > Draw-Partition-Vector”, el programa generará 

una nueva imagen de la red, esta vez atribuyendo diferentes colores para diferentes 

universidades. Completamos, así, el itinerario que nos permite visualizar con Pajek toda 

la diversidad existente en una red constituida a lo largo de diez años. Por medio de 

inspección visual, podemos verificar cuales son, al fin del período, las partes más 



densas de la red y cómo los investigadores cooperan para tejer sus telas de conocimiento 

para allá de los límites de su grupo de pesquisa, su universidad o mismo de su país. 

 

 

Gráfico 06 

Imagen de la red con particiones 

 

Si se desea descubrir como esta telaraña se constituyo a lo largo de los años, 

Pajek fornece a posibilidad de visualizarla en los diversos períodos temporales que 

abarca. Para tanto, usamos el comando “Net > Transform > Generate in Time > All”, 

informando los períodos inicial y final y el grado de separación entre períodos. En el 

caso de nuestro estudio, estos datos son 2001, 2010 y 1. Nuevamente utilizando el 

comando “Draw > Draw-Partition-Vector”, accedemos a la ventana de dibujo, dónde 

podemos navegar en el tiempo a través de los comandos “Previous” y “Next” para 

observar los pasos de construcción de la red a partir de las aristas que se forman año a 

año. 

 

 



 

 

 

 

 

 

Gráfico 08 

Imágenes de la red a través de los años 



 

 

 

Consideraciones Finales: ¿adónde va la pesquisa?  

 

Al analizar las imágenes de la red de la investigadora, percibimos que la 

conexión entre autores es más fuerte en el seno de un grupo de pesquisa, a despecho de 

cuales sean sus orígenes nacionales o institucionales. Hemos entendido así que los 

vectores más significativos de la contribución no son aquellos favorecidos por la 

ubicación, sino que los lazos creados por los investigadores con base en sus afinidades 

teóricas. Por lo tanto, para que haya colaboración es más importante la 

complementariedad temática do que las conformaciones espaciales. 

Ese hecho sí se refuerza con los avances de las telecomunicaciones, ya sean en 

tiempo real o asíncronas. Creemos que la configuración de las telas de conocimiento es 

un ejemplo paradigmático de las transformaciones por las cuales también pasan otras 

áreas del trabajo humano. Cómo los movimientos individuales hacia la innovación se 

dan con más facilidad y agilidad do que los cambios institucionales, los investigadores 

que contactan colegas de otros orígenes construyen puentes por las cuales podrán 

aproximarse sus universidades, por la firma de convenios, intercambio de alumnos y 

establecimiento de programas de pesquisa conjunta. 

Es indudable que las fronteras nacionales continúan a jugar un rol importante. La 

capacidad de un investigador producir al lado de otro depende de las restricciones y 

incentivos que le ofrece la institución en que actúa. Hoy, en Brasil, los incentivos 

parecen crecer al mismo tiempo en que hay esfuerzo para mitigar las restricciones. De 

un lado, ampliase el volumen de programas de cooperación. De otro, preservase la 

exigencia de publicar a los investigadores. Lo necesario ahora es encontrar un camino 

para superar la valoración de los investigadores por cuánto producen para evaluar lo que 

producen y su habilidad en diseminar y multiplicar la información que obtienen, 

aproximando el conocimiento generado en la comunidad científica de la sociedad como 

un todo. 

Resta determinar cómo se inician y se reproducen los movimientos individuales 

hacia la pesquisa innovadora. Por eso, la etapa siguiente al mapeo de las redes de 

colaboración de los investigadores es entrevistarlos para conocer como articulan sus 

redes y cuáles son sus hábitos de trabajo en conjunto. Las imágenes de las telas 



generadas en Pajek son para eso un importante subsidio para orientar tales entrevistas y 

llamar la atención del investigador para aspectos de la red que no se podría percibir caso 

se partiese sólo de relaciones de obras para conducirlas.  
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